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President’s Corner by Rosalind Philips
It is hard to believe that a year has gone by and that this is my last
column as president. It has been a big year for the club. We
changed the scavenger hunt format, have a new website, changed
the structure of two of our meetings and have had some awesome
field trips. I have enjoyed being president and look forward to
continuing to be active in the club. Colleen Easley will do a
wonderful job as our next president.
We hold elections at our June General Meeting. We still need nominations for vice-president. The
vice-president is responsible for running the August planning meeting, getting speakers for the
general meeting and backing up the president. It is a great opportunity to help shape the future of
our club. In addition, the positions of Field Trip Coordinator and Equipment Custodian still need
to be filled. If you are interested in any of these positions, please contact Rosalind or Colleen.
Our field trip to Emerald Downs was spectacular. We learned lots of interesting information about
the history of the track, the Emerald Downs community, and of course about the horses. Please
take a look at the images posted in the field trip section of the website
(http://www.olympiacameraclub.org/field-trip-galleries/). If you took pictures and have not posted
some, please do. The next field trip is on June 28, 2014 to photograph Lighthouses on Puget
Sound. See Frank’s article for more details.
The Thurston County Fair is coming up soon. OCC manages the photo competition at the fair. We
can always use more help at the fair. Frank will have sign-up sheets at all the June meetings. I
would like to encourage all members to submit images for the fair. You can get all the details on
the website (http://www.olympiacameraclub.org/thurston-county-fair/). Fundamentals group this
month will be discussing how to select and get images ready for competitions.
It is time to start thinking about taking pictures for the 2014 Scavenger Hunt. The Banquet will be
held again at River’s Edge Restaurant on October 28, 2014. See the article later in the newsletter
for more details.
Summer is a wonderful time for taking pictures and the OCC is on summer schedule. The General
Meeting on June 24th will be at Edge Lake Mobile Home Park Community Center. There is no
Fundamentals group and General Meetings in July. Advanced group meets as usual. Both the
Fundamentals and Advanced groups will meet at Edge Lake Mobile Home Park Community
Center in August. The August general meeting is our yearly planning meeting and will be held at
Priest Point Park at the rose garden.

May the force, photographic force, be with you.
Rosalind
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Olympia Camera Club Board Minutes
June 3, 2014 @ 6 p.m.
Mekong Restaurant, Olympia
Present were: President Rosalind Philips, Vice
President Colleen Easley, Secretary Chris
Weinreich, Treasurer John Damitio, Membership
Coordinator Jodi Cox, Community Liaison Wes
Kirkpatrick, Past President Gene Pardee, Frank &
Terri Townsend, and Dale Easley
April Minutes: Wes moved that the May minutes
Treasurer's report for June:
Beginning Balance:

$ 2093.74

Calendar: This month the advance group subject will
be portraits and the fundamentals group subject will
be how to get the best prints from Costco. Altho there
is no general meeting in July, the advanced group will
meet. In August, both the advanced and the
fundamentals groups will meet. The club's planning
session/picnic will be in August in Priest Point Park.
Social Programs/Field Trips: June 28th Frank will
lead a trip to the Puget Sound light houses on the
eastern shore. Rosalind brought up the possibility of a
trip in August to Whidbey Island, possibly involving
a boat trip around some of the island. Everyone
thought it was a good idea.

Deposits:
$ 174.00
Membership Dues-$20.00
Member deposits for E.D.-$154.00

NPPNW (Nature Photographers of the Pacific
Northwest): The NPPNW will hold it's fall
meeting Nov.1st in Salem, OR.

Expenses:
Office Supplies-$74.28
Adobe Systems (PS rental)-$10.87
Emerald Downs Payment-$532.00
Planning Picnic Deposit-$34.00

$

651.15

PSA (Photo Society of America): The organization's
annual meeting will be in Albuquerque, New Mexico
in September. According to Frank, no one from the
club has signed up to attend.

End Balance

$ 1615.91

Savings

$ 1379.84

NWCCC (Northwest Council of Camera
Clubs): Wes reminded everyone that the NWCCC
traveling prints judging will be in October.

PayPal
Emerald Downs-$318.54
Membership (student)-$11.32

$ 329.86

Total Club Assets

$3229.86

be approved as they appeared in the newsletter.
Frank seconded and the minutes were approved.
President's Report: Per Rosalind It was a good
month -- great presentation at the general meeting,
the Emerald Downs Field trip went very well and
planning for the club's October scavenger hunt has
started with the hunt's dinner scheduled for October
28th. Rosalind said that since the newly
re-configured club groups (the fundamentals and
the advance) have met for several times now, it's
time to survey the members to see how they like the
new configuration and if they have any ideas for
improvements.

Community Liaison: 2014 Air Show Father's Day -Wes said the club will get six tickets and the people
who get the tickets must give Wes their images. Last
year several of the people who had tickets did not turn
in any photos. Capitol Land Trust -- Wes said Land
Trust people liked the pictures that club members at
their annual meeting.
Thurston County Fair: Frank passed around sign-up
sheets for setting up and staffing the photo show at
the fair, which starts the last week in July.
Old Business: None
New Business: There had been a discussion via
e-mail about how to use the club web site to inform
club members about events, classes, photo trips, etc.
that are sent to the club and are of interest but should
not be interpreted as connected nor endorsed by the
club. Colleen had researched using the club's
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Facebook to do this and presented her findings to the
board. After some discussion of this options, Gene
moved to establish a Facebook "closed group" where
those announcements could be posted. The motion
was passed.

ADVANCED PHOTOGRAPHY GROUP
JUNE 17, 2014—6:30 P.M.
Edge Lake Community Center
2014 CHALLENGE SUBJECTS:
JUNE—OCC Club Member
JULY—Machine(s) non-transportation
AUGUST—Downtown Olympia
SEPTEMBER—Olympia Capitol Campus (buildings
or grounds)
OCTOBER—Percival Landing
NOVEMBER—Food
DECEMBER—Holiday (any religion)

Meeting adjourned at 7:40
Chris Weinreich, Secretary

FUNDAMENTALS GROUP
June 10, 2014—6:30 p.m.
Capital High School POD A
This month in Fundamentals Group we will be
working on how to choose and prepare images for
the Thurston County Fair or any other competition.
We will be looking at selection criteria, using
Lightroom, Photoshop Elements and Photoshop CC
to prepare the file, printing options and framing
options. So bring some images that you are
considering in either JPEG, print form or on
FLICKR and we will all make suggestions.

RULES:
Each month the APG features both a challenge and a
critique session (prints and/or jpgs). You are
welcome to bring a total of up to 9 images,
but no more than 6 for either the challenge or
critique session. For instance, you could bring 5
challenge entries and 4 for critique, but not over 6
for either the challenge session or critique session.
Finally, that 9 number is the grand total of images
you may bring each month, including all of your
prints and/or jpgs. Otherwise, mix and match as you
wish.
QUESTIONS/COMMENTS?

GENERAL MEETING

Just send Tom Blankenship an e-mail or call him at
301-793-8500.

June 24, 2014—6:30 p.m.
Capital High School POD A

OCC CLUB OFFICER ELECTIONS

Website Stats for Website
2014

May

Number of Visits
Number of Page Views
Average Page Views per Visitor
**these stats are for our new website and
this is the first month of reporting, so that
is the reason for all of the n/a on the chart
this month

May-14
209
1388
6.64

Last Reported Change Increase
Percentage of
Month
(Decrease)
Change
n/a
n/a
n/a

n/a
n/a
n/a

n/a
n/a
n/a
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OCC FACEBOOK CHANGES
By Colleen Easley

If you're a Facebook user you have probably already "Liked" the Olympia Camera Club "Page". But now
we're heading into a slightly different direction. Instead of a Page, we are moving to a Facebook GROUP
which is more community based. Our new Group page is located here: https://www.facebook.com/groups/
OlympiaCameraClub/ This week we will be adding members who had liked our old Page over to the
Group. If you don't want to wait, go ahead and Join it yourself by heading over there and clicking on JOIN
GROUP.
Why a Group? Facebook seems to look at Pages as a way to promote your business, and as such, wants us to
pay to promote our posts. If we don't pay, they won't show the posts to everyone. This has become more and
more apparent over the past year or so. Some people would see our posts, some would not, and we had no
control over it unless we wanted to pay - which we don't!
Groups on the other hand are communities of like minded individuals who are just interested in
communicating with each other and not necessarily promoting a product or service. I think we'll find that a
Group is a much better fit for our club. If a member posts a question in the Group, it's likely an answer will
be given in a timely manner. If someone posts a photo - other members can "like" or comment on it. It's my
hope that we will develop a greater sense of community using a Group rather than the old OCC Page. If
you're a member of the group, all posts made to it will show up in your news feed. If you have notifications
turned on for the Group, you'll also get notifications every time someone posts there.
Why not just have a forum on the website? In the past we tried to run some forums on our OCC website,
but they got little to no use. I think that was because people just didn't take time to go out there and look for
new posts or if they did go, and didn't find any new posts, they got discouraged and didn't come back. With
Facebook, many of us are using it everyday, so if an OCC member posts in our Group, other members will see
it fairly quickly. Forums also require a fair amount of time to manage, and although we will have a couple
moderators on our Facebook Group, no one has to maintain the software or fix things when they don't work
right. Facebook is responsible for that.
Why didn't we create a Group to start with? I don't know the answer to that. The page was established
quite a few years back before I became the webmaster. It's possible Groups were not even available way back
then. But they are now, and the board has agreed that a Group will be a much better avenue to stay connected
via Facebook than the old Page.
What will happen to the old Page? The Olympia Camera Club "Page" will remain in place for the time
being. We have posted a message on there that we are migrating to the new Group and hopefully people
interested in the club will come over and join the Group. Eventually the Page will probably die away and be
deleted unless we find we still have a need for it.
What should I post in the Group? We hope you will feel free to post about anything related to
photography. If you have a question for the group, ask it. If you have some gear to sell, post the info. If
you've found a cool photography article on the web that you'd like to share, post a link. If you want to show
off some photos from a recent outing, post them - we'd love to see them. This is your Group and we want to
hear from you.
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THE OLYMPIA AIR MUSEUM 16TH ANNUAL AIR SHOW
By Frank Townsend

The Olympia Air Museum is presenting it's 16th annual Air Show on June 14 and 15. Our club has acted as
the event photographer for several years now and we are poised to do it again.
The museum has given us six complementary tickets to the two day event, several club members have
already signed up but we still have tickets left. If you accept this opportunity
you must provide jpeg images on some transportable device for the museum to use. Identify your images
because you will receive credit if any are used. One of Frank's covered half
the back page of their newsletter one year. You can see many of the club's images by visiting the museum's
web page.
Contact Wes Kirkpatrick wesk67@gmail.com or Frank Townsend frank_townsend@comcast.net if you wish
to participate. Please give your images to either Wes or Frank Townsend at the June membership
meeting on June 26.

A TRIP TO PUGET SOUND LIGHTHOUSES
by Frank Townsend

Mark Saturday, June 28 on you calendar for a visit to the lighthouses lining the west side of Puget
Sound. We will visit Point Robinson on Vashion Island, Point No Point on the Kitsap Peninsula and Point
Wilson in Port Townsend.
Along the way we may have time to stop in historic Port Gamble. The fun begins by leaving the Martin Way
Park and Ride, just off I-5 next to the Regal Cinema, at7:30 AM in order to catch a ferry at Point Defiance in
Tacoma. Bring snacks, drinks, and lunch as this will be a long day. We will stop for dinner on the drive
home. I've visited these sites before and can promise you will enjoy the trip.
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THURSTON COUNTY FAIR
by Frank Townsend

I may have mentioned recently that the Thurston County Fair is coming at the end of July and that our club
has a long relationship with the fair by sponsoring the Open Class Photography competition.
We begin Saturday July 26 by receiving entries at the fair grounds, entering the entry forms into our data
base, printing and attaching labels and hanging tabs. On Sunday the images are judge and we record the
awards, place ribbons, and arrange the labels printed the day before. Monday the 28th we hang the
images. During the fair we provide coverage at an info table for a three hour shift. Working on Sunday,
judging day, the club provides a lunch for judges and club members present, for those woring the info table
we provide free admission to the fair on the day of service. At present we have enough support on
Monday but could use more help on Saturday, Sunday and during the fair from July 30 through August 3.
Look for the sign up sheets during the next few club meetings or contact me for more information or to sign
up.

TRAVELING PRINT COMPETITION
by Frank Townsend

The Northwest Council of Camera Club Traveling Print Salon is a club competition. Clubs must enter a
minimum of ten (10) prints up to a maximum of twenty-five (25) prints. No club is allowed to enter more
than one shipping case . A minimum of 5 club print entries is required to enter the Color or Monochrome
categories. Maximum print and mat size is 16"x20". Minimum print size is 8x10". A four (4) print per entrant
limit may be waived only if there are insufficient club entries to make the ten (10) prints minimum
required. Each circuit club will view and judge the club entries in their own circuit and select a First,
Second, and Third place in both color and monochrome, which will serve as the first round juried judging. It
will be each club's print director's responsibility to coordinate the transfer of the prints after club judging to
the next participating circuit club. See additional rules in the General Rules for All Print Competitions.
All print entries must be shipped in a standard commercial print shipping case. Each club director is to leave
their registration form in the case after making a copy for themselves. We request that you permanently
mark your club's case on the outside cover with legible club's initials.
We must notify the Council of our intent to participate by September 1, so I must hear from at least 10
members (or 10 images) who wish to enter. If we enter I will collect our prints at the September membership
meeting on September 23 and mail them to the next club for judging.

NEW DISCOUNTS FOR OLYMPIA CAMERA CLUB MEMBERS
By Jodi Cox

Beards Framing has granted us a 25% “Artist Discount" on custom and ready made frames. We will be
making ID cards that you will be able to show to them for your discount..
They also have package deals from 35% to 50 % on 16x20, 22x28, and 24x36, and have joined with an
outside company that will offer a 15% discount for finished laminated options as well.
They also have a great new printing website that you can do from home. Check it out
on-line www.bearsframingstore.com or in the store.
Keep an eye out in your email for your new ID card and more member discounts to come!!!
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The OCC Annual Banquet and Scavenger Hunt
By Rosalind Philips

This year the Annual Banquet and Scavenger Hunt will be held on October 28, 2014 at River’s Edge
Restaurant in Tumwater. We used this venue for the first time last year and everyone was much happier
ordering off the menu, so we will do the same this year. We do have to have a head count, so please send your
reservation to Jodi Cox, our membership coordinator at coxtribe@comast.net by October 21, 2014. The details
of how to participate in the scavenger hunt are in the next article or you can get them on the website at
http://www.olympiacameraclub.org/scavenger-hunt/
________________________________________________________________________________________
Name: _______________________________________
Address: __________________________________________
Phone: ____________________________________________
Images MUST fit the category. Use your IMAGINATION!
Mail your CD of digital images and this form to Rosalind Philips
4643 Indian Summer DR SE
Olympia, WA 98513

Num
01
02
03
04
05
06
07
08
09
10
11
12
13
14
15

Category
Mirror Mirror
Opposite
Thirst
Kiss
Collections
Hooked
Patterns
Gold
Dreamy
Olympia
Speed
Clean
Messy
Red
Self Identification

Description

Due no later than October 14, 2014
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2014 Olympia Camera Club Official Scavenger Hunt Rules
This year, members will have two ways to participate in Banquet Slide Show entertainment.
Submit one image for each of the 15 words below. You many take as many images as you like and do as
much processing as you like, but you can only submit one image for each word.
OR
Submit 10-15 of your favorite/best images taken between 10/1/2013 and 10/1/2014. You may do as much
processing as you like on the images.
Rules
All images must be JPEGS – no RAW or TIFF images.
The images must not exceed 1024 pixels in width or 768 pixels in height. The resolution should not exceed
72 dpi.
Scavenger Hunt Images. Name your images as Sxx_Name_word.jpg where
S means scavenger hunt, xx is the number of the word and word is the category. For example, an
image submitted for the 5th word of Blue would be named S05_RosalindPhilips_Blue.jpg.
Please include a list of your images with descriptions.
Favorite/Best of 2013 images. Name your images as Bxx_Name_ImageName.jpg .
B means Favorite/Best of 2014, xx is the number of the image, Name is your name and ImageName
is the name of the image. For example the eighth image I submit would be named,
B08_RosalindPhilips_BergyBit.jpg.
Please include a self Identification Image.
Please include a list of your images with descriptions.
Please burn your images to a CD or DVD.
Images are due no later than Tuesday, October 14, 2014 at the Digital Meeting. You can bring your images
to the meeting or mail them to Rosalind Philips, 4643 Indian Summer Dr SE; Olympia WA, 98513.
We will watch the two slide shows at the Banquet on October 28th.
Please contact Rosalind at RosalindPhilips@comcast.net or at 360-790-2814 with any questions.
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Emerald Downs Field Trip
by Colleen Easley

The May field trip to Emerald Downs was a tremendous success. Thank you, Frank and Rosalind for putting
this together for our club. On May 24, close to forty people traveled to Auburn on a beautiful sunny day to
experience the sounds, sights, and smells of the age old tradition of horse racing. Many of us had never been
to a horse race before, so this was an eye-opening experience. We started our day by meeting up with our
guide, Vicki Potter. She gave us a run down of what would be happening and where we could go to
photograph and then cut us loose to enjoy photographing the morning training session. Around 10:30 we
gathered for a group photo and then jumped aboard a tram for a guided tour of the stable area. It was
amazing to learn that the complex is like a mini town within a town. I should have taken notes to better tell
about all the facilities the guide told us about, but some included a day care facility, a clinic, veterinary

hospital, drug and alcohol treatment services, a community center, and the Quarter Chute Cafe for owners,
trainers, jockeys and other race personnel. Once we finished the tram tour, we went into the Quarter Chute
and found that they had reserved multiple tables just for our group. Those that wanted to had a quick bite to
eat while about half the group went into the barns for an up-close and personal visit with some of the
horses. Then the two groups traded places. By the time both the barn tours were complete it was almost
time for the first race of the day to begin. We walked back to the grandstand and found our reserved section
and waited in great anticipation for the Call to Post. Not many stayed in their seats, however, because we
were free to roam of the grandstands and along the rail. Some of us placed our first ever bet on a horse and
some actually won a few bucks! Some folks stayed for a few hours of racing and some stayed until the last
race of the day was over. But no one left without having had an exciting day and getting lots of great shots
of the magnificent horses and their riders. We really hope we can do this again sometime in the future, and if
we do - you won't want to miss it!
See our Flickr page for more photos: https://www.flickr.com/groups/emeralddowns2014/
If attended the trip, but you haven't put your photos in the Flickr group yet, please join the above group and
get your photos added for all to enjoy.
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Please be sure to check out other images from the
Emerald Downs Field Trip on the clubs website/
FLICKR album.
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Q&A with Tim Grey
By Colleen Easley

Question: Can you go from Lightroom to Elements to edit a photo instead of
Photoshop, and if so how?
Tim's Answer: Yes, you can indeed use Photoshop Elements rather than Photoshop to optimize photos
from Lightroom. This is a topic that has come up much more frequently at events I’ve presented at since the
switch to a subscription model for Photoshop, though Photoshop Elements has always represented a less
expensive option compared to Photoshop that still offers many of the image-optimization benefits found in
Photoshop.
The key to using Photoshop Elements as an editor from Lightroom is to configure the Photoshop Elements
Editor as an external editor in Lightroom. To get started, bring up the Preferences dialog, which you can
find on the Edit menu on the Windows version of Lightroom or the Lightroom menu on the Macintosh
version of Lightroom. In the Preferences dialog choose the External Editing tab.
In the Additional External Editor section of the dialog you’ll want to create a preset for Photoshop
Elements. Start by clicking the Choose button in this section, and navigate to the folder where Photoshop
Elements is installed. Select the Elements Editor application and click the Choose button.
You can then select your preferred options for the derivative file that will be created when you send an
image to the Elements Editor. You’ll generally want to use a TIFF or PSD file format in order to retain the
ability to make use of layers. You can then choose a preferred color space (Adobe RGB or sRGB are the
standard options for Photoshop Elements), and a bit depth. While the 16-bit per channel mode is preferred
when optimizing images, most features of Photoshop Elements do not support 16-bit per channel mode, so
I generally use 8-bit per channel mode when editing in Elements.
Once you’ve established your settings for Photoshop Elements as an external editor, click the Preset popup
in the Additional External Editor section and choose “Save Current Settings as New Preset” from the popup.
Specify a meaningful name (such as “Photoshop Elements”) and click Create.
You can now close the Preferences dialog, having saved your preset for Photoshop Elements. When you
want to edit a photo in Elements, select that image, and then choose Photo > Edit In > and then the name of
the preset you saved for Photoshop Elements. When you’re finished working with the image in Elements,
simply choose File > Save from the menu, then File > Close, and when you return to Lightroom you’ll see
the new image you created included in your catalog.

Tim Grey's articles are reprinted with permission. You can subscribe to the free Ask Tim Grey eNewsletter
at AskTimGrey.com.
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Phototunities— A listing of events of visual interest for OCC members
June 13–15 Republic-Prospectors' Days
Rush to Republic for this three-day celebration of the town's heritage, featuring gold-panning demonstrations,
a logging show, fun run and more. 509.850.2500, prospectorsdays.com
June 13–15 Dayton—All Wheels Weekend
Music on Main Street, Friday night fireworks, Saturday's demolition derby and "drag" races, and many shiny
classic cars make for a memorable event. 800.882.6299, allwheelsweekend.com
June 14–15 Union Gap—Old Town Days
The community celebration kicks off with a parade of antique vehicles down Main Street, and includes a
3on-3-soccer tournament, live music and a Civil War re-enactment. Fullbright Park, 509.457.8735,
centralwaagmuseum.org
June 19–22 Burlington-Berry Dairy Days
Each year, the community serves up loads of fresh, local strawberry shortcake, as well as a fun car show, salmon barbecue and more. 360.757.0994, burlington-chamber.com
June 19–22 Richland—Cool Desert Nights
This popular classic car, street-rod and motorcycle event offers up car cruises, street dances, a show-and-shine
and a pancake breakfast. 509.736.0510, cooldesertnights.com
June 20–22 Seattle—Fremont Fair and Solstice Parade
Seattle's beloved Fremont neighborhood festival centers around the quirky Solstice Parade and also boasts
decorated art cars, a beer garden and four entertainment stages. 206.633.0422,fremontfair.org
June 21 Eatonville—Rod Knockers Show and Shine
The car show—with some 300 classic and custom vehicles, plus door prizes and raffles—makes for a fun day
in the shadow of Mount Rainier. 360.832.4000, eatonvillechamber.com
June 27–29 Ocean Shores—Sand and Sawdust Festival
Sand sculptors on the beach and chain-saw carvers in the Convention Center show off their respective art
forms. 360.289.3887, oceanshoresact.com
June 28 Whidbey Island- -Whidbey Island Garden Tour
Explore a gamut of horticultural styles on a self-guided tour of five gardens at Whidbey's south end.
360.321.4191, wigt.org
June 28–29 Bellevue-Bellevue Strawberry Festival
Revitalizing an old Bellevue tradition—when strawberry farming was one of the region's main activities—this
festival at Crossroads Park offers entertainment, an auto show and, of course, strawberries galore.
425.450.1049, bellevuestrawberryfestival.org
July 5 Longview-Bow-Tie Bash
Longview's car show-and-shine spotlights American-made and American muscle-powered automobiles. Commerce Avenue, 360.578.2563, columbiarivercorvettes.com
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June 28–Aug. 3 Seattle-Seafair
The roster for this annual summer bash includes "pirates" landing on Alki Beach (June 28), the Milk Carton
Derby at Green Lake (July 12), the Torchlight Parade (July 26), and hydroplane races and maneuvers by the
U.S. Navy Blue Angels at Lake Washington (Aug. 1–3). 206.728.0123, seafair.com
July 5 Camas-Camas Classic Car Show
Classic and specialty cars fill the tree-lined streets downtown, complemented by live music and food vendors.
360.216.7378,downtowncamas.com
July 6 Gig Harbor-Wings and Wheels
This dual aviation/car show promises more than 150 classic and custom cars, plus vintage warbirds, biplane
rides and aerial demonstrations. Tacoma Narrows Airport, 253.507.9357,freedomfair.com
July 10–13 Kent-Kent Cornucopia Days
The fun includes everything from a street fair with more than 600 vendors to a youth soccer tournament and
dragon-boat races. 253.852.5466, kcdays.com
July 11–12 Redmond-Redmond Derby Days
The bicycle Criterium is the centerpiece of a festival that also includes a grand parade, live music, a beer-andwine garden and fireworks. 425.556.2360, redmondderbydays.com
July 11–13 Amboy-Amboy Territorial Days
Amboy pays tribute to its heritage with festivities such logging competitions, a parade and lawn mower races.
Amboy Territorial Park, tdays.org
July 12 Lynnwood-Concours d'Elegance at The Wood
More than 60 classic, sports and muscle cars—including a special display of "brass-and-nickel-era" vehicles—
dazzle attendees at this fundraiser for the Alderwood-Terrace Rotary Club. Lynnwood Golf Course,
206.546.2724, concoursatthewood.com
July 12–13 Elma-Antique Tractor Pull and Engine Show
This salute to farm machinery includes a tractor pull, vintage engine and tractor displays and more. Grays
Harbor County Fairgrounds, 360.482.2651, visitgraysharbor.com
July 16–20 Olympia-Capital Lakefair
A carnival, battle of the bands, grand parade, fireworks and other activities energize the state capital.
360.943.7344, lakefair.org
July 16–20 Long Beach-Sandsations
Sculptors transform mountains of sand into artful displays, both in town (Wednesday through Friday) and during Saturday's competition at the beach. sandsationslongbeach.com
July 18–19 Westport-Eastside Street Rods Show and Shine
Tricked-out rides are the star attractions in a day that includes a poker run, parade and show-and-shine.
360.268.9029,westportcam.com
July 18–20 Sequim-Sequim Lavender Festival
Seven lavender farms open to the public for tours, while the downtown street fair offers 150 booths selling
crafts and soothing lavender products. 360.681.3035, lavenderfestival.com
July 18–20 Vashon Island-Vashon Island Strawberry Festival
The jam-packed weekend includes Saturday's grand parade, Sunday's classic car parade, and creative
strawberry-themed foods. 206.463.6217, vashonchamber.com
http://www.aaawashingtonjourney.com/events/index.asp
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June 2014
Olympia Camera Club Monthly Meetings
The Fundamentals of Photography Group
Monthly on the Second Tuesday of the Month—June 10, 2014
6:30 p.m. —8:30 p.m.
Meeting Topic: How to choose & prepare images for fair entry
Contact, Rosalind Philips at RosalindPhilips@comcast.net

The Advanced Photographers Group (APG)
Monthly on the Third Tuesday of the Month— June 17, 2014
6:30pm to 8:30pm
Edge Lake Mobile Home Park - Community Center, 3928 21st Ave SE, Lacey
Meeting Topic: Images of OCC Club Members
Contact, Tom Blankenship at tom@tomblankenship.com

Koffee Klatch Meet up, Every Other Wednesday Morning
from 9:00 am to 11:00 am
Panera’s Bakery, 2525 Capitol Mall Drive SW, Westside of Olympia
Open discussions about photography and other topics of interest.
Contact, Wes Kirkpatrick at wesk67@gmail.com

General Meeting
Monthly on the Fourth Tuesday of the Month
June 24, 2014, 2014 6:30 p.m. —8:30 p.m.
Capital High School POD A, Westside of Olympia
Meeting Topic: OCC Club Elections
Contact, Rosalind Philips at RosalindPhilips@comcast.net

Monthly Business Meeting, First Tuesday of the Month
July 1, 2014, 6:00 pm to 7:30 pm
Meeting at Mekong Restaurant (Downtown Olympia, 125 Columbia St. NW)
Open to all. Contact, Rosalind Philips at RosalindPhilips@comcast.net
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Olympia Camera Club
PO Box 13333
Olympia, WA 98508-3333
Memberships with

Committee Chairs
Community Liaison

Advanced Photography Group Fundamentals of Photography

Wes Kirkpatrick
wesk67@gmail.com

Tom Blankenship
tom@tomblankenship.com

Rosalind Philips
RosalindPhilips@comcast.net

Equipment Custodian

Newsletter Editor

NWCCC Liaison

Gene Pardee
gene@egp-photo.com

Teri Dean

NWCCC Traveling Prints

PSA Representative

Scavenger Hunt

Vacant position

Frank Townsend
Frank_townsend@comcast.net

Rosalind Philips
RosalindPhilips@comcast.net

Thurston County Fair

Video Group

Terri Townsend
Frank_townsend@comcast.net

Dottie Hall
dottiehall@comcast.net

Wes Kirkpatrick
OlympiaCameraClubNewsletter@gmail.com wesk67@gmail.com

Social Programs
Frank Townsend
Frank_townsend@comcast.net

Webmaster
Colleen Easley
ceasley@me.com

